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After completing this lesson, you will be able to:
1. View and print charts.

2. Work with chart elements.

3. Create charts.

4. Edit chart data.

5. Use images, gradients, and textures for a data series.

6. Create a combination chart.

A chart is a visual representation of information in a worksheet. Charts can 
help you make comparisons, identify patterns, and recognize trends.

You can create a chart on the same sheet as its data or on its own sheet 
in the workbook. In either case, a chart is linked to the data used to create it 
and is updated when you edit the data.

MCAS OBJECTIVES

In this lesson:
XL07 4.1
XL07 4.1.1
XL07 4.1.2
XL07 4.1.3
XL07 4.2
XL07 4.2.1
XL07 4.2.2
XL07 4.2.3

OBJECTIVES

 Estimated Time: 2 hours

Lesson 9

Building Charts

EX-222

NOTE

The workbooks you create and use in this 
course relate to the Case Study (see the 
frontmatter of the book) about Klassy 

Kow Ice Cream, Inc., a fictional ice cream 
company.

TEACH
Teaching Resources:
This text is supported by Classroom 
Presentations in a PowerPoint format. 
For this lesson, use Excel Classroom 
Presentation 9.

PREPARE
Point out to students that the learning objectives 
show what they will learn in the lesson. Each 
heading in the lesson correlates to a learning 
objective.
Required Files: SeptChart, MayChart, ComboChart
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Viewing and Printing a Chart
A chart that appears on the same sheet as the data is a graphic object and 
can be selected, sized, moved, and edited. An object is a separate, clickable 
element or part of a worksheet or chart. When a workbook has objects, you 
can use the Selection pane to select, view, and rearrange them.

Exercise 9-1 VIEW A CHART OBJECT

When you select a chart, the Chart Tools are activated. These tools include 
three command tabs: the Design tab, the Layout tab, and the Format tab.

 1. Open SeptChart. The Zoom size is set to 75% so that you can see 
more of the worksheet and the chart without scrolling.

 2. Click in the white chart background area to select the chart. The 
Chart Tools command tabs are now visible. The chart is surrounded 
by a light frame.

 3. Press Alt  to see the KeyTips. Key jo to select the Chart Tools Format 
tab. The Current Selection group shows that the chart area is the 
active chart element.

 4. In the Arrange group, click the Selection Pane button . This 
worksheet has a chart and a text box. The Eye button  toggles the 
object’s visibility on/off.

 OBJECTIVE 1 OBJECTIVE 1

Figure 9-1
Chart selected in the 

worksheet
SeptChart.xlsx

WeeklySales sheet

Chart Elements box

Plotted data
Selection panec

  Objective 1 Assignment:
Exercise 9-26 (Skills Review) can be 
assigned after completing Objective 1.

Discuss and demonstrate how to 
select a chart and its objects. Point 
out each object’s selection handles.

Excel Classroom 
Presentation 9.c

hin1926X_ch09_EX221-EX251.indd Page EX-223  9/29/08  7:53:05 PM s-080 /Volumes/207/MHBR074/work%/indd%0/excel%0



Ex
ce

l 2
00

7

 5.  Click the Eye button  for TextBox 3. The text box 
is the company name in the top-right corner of the 
chart. It’s hidden now.

 6.  Click the Eye button  for TextBox 3 again to 
display it.

 7. Toggle the visibility of Chart 2 on/off.

Exercise 9-2 PRINT A CHART OBJECT

 1. Click cell A1 to deselect the chart. The background frame is removed 
from the chart.

 2. Press Alt  and key n. The Insert tab is active.

 3. Key h to choose Header & Footer.

 4. Click the Header button . A list of header arrangements opens.

 5. Choose the second option from the bottom of the list—the user 
name, the page number, and the date.

 6. Click the user name and change it to your name.

 7.  Click cell A1 and print the sheet. The worksheet and 
the chart print on a single page.

 8.  Click in the white background chart area to select 
the chart.

 9. Press Ctrl � P . In the Print what group, Selected Chart is chosen. 
Click OK. The chart prints by itself in landscape orientation. When 
you print a selected element, the header is not included, because a 
header is a page setting.

 10. Click cell A1. Click the Normal button  in the status bar.

 11. Click the Close button  in the Selection & Visibility pane.

Working with Chart Elements
A chart is composed of many clickable elements or objects. These elements 
are formatted by the current layout and style, but you can change each object 
on its own, too. Here is a brief description of Excel chart elements:

• The chart area is the background for the chart. It can be filled with a 
color or pattern.

• An axis is the horizontal or vertical line that encloses the data.

 OBJECTIVE 2 OBJECTIVE 2

NOTE

The user name in a classroom setting is 
set by the class or network administrator.

NOTE

In this worksheet, the text box is on top 
of the chart; otherwise it would be hidden 

by the chart’s white background.

EX-224 UNIT 3 Enhancing Worksheet Appearance

  Objective 2 Assignment:
Exercise 9-27 (Skills Review) can be 
assigned after completing Objective 2.

hin1926X_ch09_EX221-EX251.indd Page EX-224  9/29/08  7:53:06 PM s-080 /Volumes/207/MHBR074/work%/indd%0/excel%0



Excel 2007

• The horizontal (category) axis is created from row or column headings 
in the data. A category describes what is shown in the chart.

• The vertical (value) axis shows the numbers on the chart. Excel creates 
a range of values (the scale) based on the data.

• An axis title is an optional title for the categories or values.

• The plot area is the rectangular area bounded by the horizontal and 
vertical axes.

• The chart title is an optional title or name for the chart.

• A data series is a collection of related values from the worksheet. These 
values are in the same column or row and translate into the columns, 
lines, pie slices, and so on.

• A data point is a single value or piece of data from the data series.

• A data marker is the object that represents individual values. The 
marker can be a bar, a column, a point on a line, or an image.

• A legend is an element that explains the symbols, textures, or colors 
used to differentiate series in the chart.

• A gridline is a horizontal or vertical line that extends across the plot 
area to make it easier to read and follow the values.

• A tick mark is a small line or marker on the horizontal (category) and 
vertical (value) axes to help in reading the values.

Figure 9-2
Excel chart elements Vertical (value) axis

Gridlines Plot area (wall 
with gridlines)

Chart area (white 
background)

Horizontal (category) axis

Data point (each column)

EX-225LESSON 9 Building Charts

Excel Classroom 
Presentation 9.c

c
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Exercise 9-3 CHANGE THE CHART LAYOUT

The Chart Tools command tabs include layout and style choices to help you 
build a professional-looking chart. The Chart Layouts gallery offers various 
arrangements of chart elements for each chart type.

 1. Click the chart background. Click the Chart Tools Design tab.

 2. In the Chart Layouts group, click the More button . The Chart 
Layout gallery opens.

 3. Click Layout 2. The chart is redesigned to show values above the 
columns with no values along the vertical axis.

Figure 9-3
The Chart Layouts 

gallery
SeptChart.xlsx

WeeklySales sheet

 4.  In the Chart Layouts gallery, click Layout 3. This is 
similar to Layout 1 but with a legend at the bottom 
(Series 1).

 5.  In the Chart Layouts group, click the More button 
. Click Layout 4. This layout does not include a 

chart title.

 6. Choose Layout 3. The chart title object is a placeholder and will need 
to be rekeyed (later in the lesson). There is a legend at the bottom.

TIP

In a column chart with one series, you do 
not need a legend.

Excel Classroom Presentation 9.c

c
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Exercise 9-4 CHANGE THE CHART STYLE

The Chart Styles gallery provides variations in colors and effects for chart 
elements using the document theme. There are many predefined styles that 
combine theme colors and effects.

 1. In the Chart Styles group, click the More button . The Chart Styles 
gallery opens. Your chart uses Style 19, but the column colors were 
modified.

 2. Click Style 34. The columns show a flat effect in a new color.

Figure 9-4
The Chart Styles 

gallery
SeptChart.xlsx

WeeklySales sheet

 3. In the Chart Styles group, click the More button . Click Style 44. 
This style changes the background color, too.

 4. Choose Style 20. The columns again have a beveled effect.

Exercise 9-5  EDIT AND FORMAT THE CHART TITLE

Chart elements show a ScreenTip when you hover over them. To edit an 
element, select it by pointing and clicking. When an element is selected, it 
shows a bounding frame and selection handles, and its name appears in the 
Chart Elements box on the Chart Tools Format tab. Selection handles are 
small circles, rectangles, or dots at the corners and along each border of the 
bounding frame. They can be used to size the element.

Excel Classroom Presentation 9.c
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 1. Click the Chart Tools Format tab.

 2.  Point at the placeholder text Chart Title on the 
chart and click. The object is selected and shows 
a bounding border with four selection handles. Its 
name appears in the Chart Elements box in the 
Current Selection group.

 3.  Point at an edge of the object to display a four-
pointed arrow. This is the move pointer.

 4. Drag the object left to align with the values on the vertical axis.

 5. Triple-click Chart Title. This is placeholder text.

 6. Key Nevada sales for September. The placeholder text is replaced.

 7. Triple-click Nevada sales for September to select it. Point at the Mini 
toolbar.

 8. Click the Italic button . Change the font size to 16.

NOTE

The bounding box and selection handles 
do not print.

Figure 9-5
Editing the chart title

SeptChart.xlsx
WeeklySales sheet

 9.  Click the white background area of the chart to 
deselect the title.

NOTE

If you accidentally select the text box with 
“Klassy Kow Ice Cream, Inc.,” the Drawing 
Tools Format command tab is activated. 

Click away from that area in the chart 
background.

Excel Classroom Presentation 9.c

c
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Exercise 9-6     SET SHAPE FILL AND EFFECTS

The data series in this chart are the values from column G. 
Each value is represented by the height of its column. 
The values are plotted against the value (vertical) axis, the 
column of numbers at the left. The category for this chart is 
the city name, shown along the horizontal axis.

 1. Make sure the chart is selected.

 2.  Rest the mouse pointer on the Reno column to see its ScreenTip. It 
is one data point from the series.

 3.  Click the Reno column. The entire data series is selected, and the 
Chart Elements box shows Series 1. This is the first (and only) series 
in this chart.

 4. In the Shape Styles group on the Chart Tools Format tab, click the 
More button  for the Shape Styles. The styles include some with an 
outline and no fill, some with both outline and fill, and beveled and 
shadow styles.

TIP

Many chart experts refer to the value axis 
as the y-axis and the category (horizontal) 

axis as the x-axis.

Figure 9-6
Changing the 
shape’s style

SeptChart.xlsx
WeeklySales sheet

Tell students that the category axis describes what is charted. It can 
be horizontal or vertical depending on the chart type.

Excel Classroom 
Presentation 9.c
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 5. Choose Intense Effect, Dark 1. Each column now has a reflection, too.

 6. In the Shape Styles group, click the Shape Fill button .

 7. Choose White, Background 1, Darker 35% in the first column.

 8. In the Shape Styles group, click the Shape Effects button . 
Most effects are available for this shape.

Figure 9-7
Changing the 
shape’s effect

SeptChart.xlsx
WeeklySales sheet

 9. Hover over Shadow to display its gallery. Then choose Offset Diagonal 
Bottom Right (first effect in the Outer group).

 10. Click the white chart background.

Excel Classroom 
Presentation 9.c

c

hin1926X_ch09_EX221-EX251.indd Page EX-230  9/29/08  7:53:12 PM s-080 /Volumes/207/MHBR074/work%/indd%0/excel%0



LESSON 9 Building Charts

Excel 2007
EX-231

Exercise 9-7 SET AND FORMAT DATA LABELS

A data label is an optional title shown for each value. It is the value from 
column G in this case. The Chart Tools Layout tab provides options for 
setting and positioning individual chart elements.

 1. Click the Chart Tools Layout tab.

 2. Hover over the Data Labels button  and read its ScreenTip. Click 
one of the labels.

 3. Click the Data Labels button  and choose Outside End. The value of 
each data point appears above its column.

 4. Rest the mouse pointer on one of the data labels to see the 
ScreenTip.

 5.  Click the Chart Tools Format tab. Click the arrow 
next to the Chart Elements box and choose Series 1 
Data Labels. The data labels are selected and show 
bounding boxes and selection handles.

 6.  Click the Home tab and change the font size to 
9 points.

Exercise 9-8 FORMAT THE AXES

The Horizontal (Category) Axis is the x-axis in this chart, the city names.

 1. Position the mouse pointer on a city name to see its ScreenTip.

 2. Click the Chart Tools Format tab. Click the Chart Elements arrow and 
choose Horizontal (Category) Axis. The city names are selected and 
show a bounding box and selection handles.

 3. On the Home tab, change the font size to 8 points.

 4. Click one of the values along the Vertical (Value) Axis, the y-axis, the 
sales in dollars.

 5. Click the Chart Tools Layout tab. Click the Axes button . Choose 
Primary Vertical Axis and None. With the data labels displayed, you 
don’t need the axis values.

 6. Right-click one of the data labels (above the columns). Choose 
Format Data Labels.

 7. Click Number. Choose Currency with 0 decimals and $ as the Symbol. 
Click Close.

NOTE

The Chart Elements box is in the Current 
Selection group on both the Layout and 

Format command tabs.
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 8. Click a cell in column I to better see the chart.

Exercise 9-9  FORMAT THE PLOT 
AND CHART AREAS

 1. Click Series 1 at the bottom of the chart. This is the legend. There is 
one series in this chart, the amount shown by each column.

 2. Press Delete .

 3. Click the Chart Tools Format tab. Click the Chart Elements arrow 
and choose Plot Area. The plot area is the background grid for the 
columns, currently white. It is selected.

 4.  In the Current Selection group, click the Format 
Selection button .

 5.  On the Fill pane, choose No fill. Click Close. The 
color (white) is removed but is not noticeable yet.

 6.  Click the Chart Elements arrow and choose Chart Area. 
The chart’s background is selected; it is white, too.

 7. Click the Format Selection button .

 8. On the Fill pane, choose No fill. Click Close. You can now see that 
there is no fill color.

 9. Click cell A1.

 10. Save the workbook as [your initials]9-9 in a folder for Lesson 9.

 11. Close the workbook.

Figure 9-8
Formatted data 

labels
SeptChart.xlsx

WeeklySales sheet

TIP

Choosing no background color means 
your chart will print faster than with a 
white background color and look the 

same on white paper.

Excel Classroom 
Presentation 9.c
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Creating Charts
Before you build your own chart, you must consider two questions. First, 
what data should you use for the chart? And, second, what type of chart is 

best for that data? With practice and experience, you can 
develop a good sense of how to identify data and choose 
chart types.

You can create basic chart types such as column charts, 
bar charts, pie charts, and line charts. You can also create 
specialized charts such as doughnut and radar charts. 
Table 9-1 describes the chart types available.

 OBJECTIVE 3 OBJECTIVE 3

NOTE

The appearance of a button in the 
Ribbon is affected by the screen size 

and resolution setting. All buttons have 
ScreenTips for clarification.

TABLE 9-1 Chart Types in Excel

Type Definition

 Column  A column chart is the most popular chart type. Column charts show how values change 
over a period of time or make comparisons among items. They can be prepared with 
3-D effects or stacked columns. Categories are on the horizontal axis (x), and values are 
on the vertical axis (y). The shape can also be a cone, a cylinder, or a pyramid.

 Line  Line charts show trends in data over a period of time. They emphasize the rate of 
change. 3-D effects are available. Lines can be stacked and can show markers, a 
symbol that indicates a single value.

 Pie  Pie charts show one data series and compare the sizes of each part of a whole. Pie 
charts should have fewer than six data points to be easy to interpret. A pie chart can 
use 3-D effects and can show exploded slices.

  Bar  Bar charts illustrate comparisons among items or show individual figures at a specific 
time. Bar charts can use 3-D effects and stacked bars. Categories are on the vertical 
axis (y). Values are on the horizontal axis (x). The shape can also be a cone, a cylinder, 
or a pyramid.

  Area  Area charts look like colored-in line charts. They show the rate of change and 
emphasize the magnitude of the change. 3-D effects are available.

  Scatter  Scatter charts are used to show relationships between two values, such as comparing 
additional advertising to increased sales. Scatter charts do not have a category; both 
axes show numbers/values.

  Stock  Stock charts are often called “high-low-close charts.” They use three series of data in 
high, low, close order. They can also use volume as a fourth series.

  Surface  Surface charts illustrate optimum combinations of two sets of data. They show two 
or more series on a surface. Surface charts can use 3-D effects.

  Doughnut  Doughnut charts compare the sizes of parts. A doughnut chart has a hole in the 
middle. A doughnut chart shows the relative proportion of the whole. A doughnut chart 
can show more than one data series, with each concentric ring representing a series.

  Bubble  Bubble charts compare sets of three values. They are like scatter charts with the third 
value displayed as the size of the bubble. Bubble charts can be 3-D.

  Radar  Radar charts show the frequency of data relative to a center point and to other data 
points. There is a separate axis for each category, and each axis extends from the 
center. Lines connect the values in a series.
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Exercise 9-10  CREATE AND EDIT A CHART SHEET

After you select values and labels, press F11  to create a chart sheet with the 
default chart type. It is inserted on a new sheet, and you can edit it like any chart.

 1. Open MayChart. There is no chart yet.

 2. Select cells B6:C11. This range includes the province/country 
category and the values.

 3. Press F11 . A column chart is inserted on its own sheet.

 4. On the Chart Tools Design tab in the Chart Layouts group, click the 
More button .

 5. Choose Layout 3. This layout includes a chart title and a legend (at 
the bottom).

 6. Click the chart title object. Its bounding box and selection handles 
are visible.

 7. Triple-click the placeholder text. Key Number of Kowabungas Sold.

 8. Click any column and notice that the entire series is selected.

 9. While all columns are selected, click the “British Columbia” column. 
It is selected alone.

 10. Click the Chart Tools Format tab. In the Shape Styles group, click the 
Shape Fill button .

 11. Choose Red, Accent 2 in the sixth column. Only the selected column 
is changed.

Figure 9-9
Changing an 

individual column
MayChart.xlsx
Chart1 sheet

Verify that the default chart type is column on classroom 
computers. To change the default chart type, click the 
Dialog Box Launcher in the Charts group on the Insert tab. 
Choose the type and click Set as Default Chart.

Make sure students can distinguish 
between selecting the data series 
and selecting a data point.

Excel Classroom 
Presentation 9.c

c
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 12. Click the legend at the bottom of the sheet and press Delete .

Exercise 9-11  CREATE A CHART OBJECT

A chart object appears on the same sheet as the data; it may also be called 
an embedded chart. You create it by choosing the chart type from the Insert 
command tab.

 1.  Click the KowabungaSales tab. Cells B6:C11 are still 
selected.

 2.  Click the Insert tab. The Charts group includes 
buttons for the most commonly used chart 
types.

 3.  Click the Pie button . You can create two- or three-dimensional 
charts. A ScreenTip describes each type when you hover over the icon.

TIP

The keyboard shortcut to create a 
chart object using the default chart 

type is Alt � F1 .

Figure 9-10
Creating a pie chart

MayChart.xlsx
KowabungaSales 

sheet

 4. In the 2-D list, choose Pie. The chart is on the worksheet with its data.

Exercise 9-12  MOVE AND SIZE A CHART OBJECT

The selection handles for the chart object are three dots arranged in a 
triangle shape on the corners. The handles are four dots arranged in a row in 
the middle of each edge. The move pointer is a four-pointed arrow; the sizing 
pointer is two-pointed.

 1.  Point at the top edge of the chart object to display a four-pointed 
arrow. Drag the chart so that its top-left corner aligns at cell A14.

Excel Classroom 
Presentation 9.c
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 2.  Point at the bottom-right selection handle. A two-
pointed sizing pointer appears.

 3.  Click and drag the bottom-right selection handle 
to cover cell E32. As you drag, the chart is made 
larger.

Exercise 9-13  CHANGE THE LAYOUT AND STYLES

 1. Click the Chart Tools Design tab. In the Chart Layouts group, click the 
More button .

 2. Choose Layout 5. This layout includes a chart title, no legend, and 
data labels inside the pie slices.

 3. In the Chart Styles group, click the More button .

 4. Choose Style 17. The slices are shown in shades of gray.

 5. Click the Chart Tools Format tab. Make sure that the chart area is the 
current selection.

 6. For Shape Styles, click the More button .

 7. Hover over several different styles. Since the chart area is selected, 
the entire object is affected.

 8. Press Esc  to close the gallery without making a change.

 9. Point at any pie slice, but away from the label and click.

 10. For Shape Styles, click the More button .

 11. Hover over several styles. Now the slices would be affected, not the 
background.

 12. Press Esc  to close the gallery without making a change.

 13. While the slices are selected, click only the Alberta slice. You should 
see selection handles for just this slice.

NOTE

Change the Zoom size so that you can see 
cell A14 and row 30.

Figure 9-11
Pie chart with a 

single slice selected
MayChart.xlsx

KowabungaSales 
sheet

Excel Classroom 
Presentation 9.c
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 14. Click the More button  for Shape Styles.

 15. Hover over several styles. Now just one slice would be affected.

 16. Press Esc .

 17. Click the chart title object.

 18. Triple-click the placeholder text and key Kowabunga Sales.

 19. Right-click the pie and choose Format Data Labels.

 20. On the Label Options pane, click to select Percentage.

 21. Click Close. The slices now show the name and the percentage.

Exercise 9-14  CREATE A BAR CHART SHEET

You can create a chart object and later move it to its own sheet. It is still 
linked to the data in the worksheet.

 1. Select cells B6:C11 and click the Insert tab.

 2. In the Charts group, click the Bar button .

 3. In the 3-D group, choose Clustered Bar in 3-D, the first icon. The 
chart object appears on your worksheet.

 4. In the Location group, click the Move Chart button . The Move 
Chart dialog box allows you to move the chart to its own sheet or to 
another worksheet in the workbook.

Figure 9-12
Move Chart dialog 

box
MayChart.xlsx

KowabungaSales 
sheet

 5. Choose New sheet and click OK. The chart is placed on a new sheet.

 6. Click Series 1 and press Delete . That was the legend.

 7. Click the Chart Tools Layout tab. In the Labels group, click the Chart 
Title button .

 8. Choose Above Chart. A placeholder object is inserted.

c

Excel Classroom 
Presentation 9.c
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 9. Triple-click Chart Title and key Comparison of Weekly Sales.

 10. Click anywhere in the side panel to deselect the chart.

Exercise 9-15  ADD GRIDLINES AND A DATA TABLE

A data table lists the values and names displayed in the chart. It is separate 
from the chart and appears below the horizontal axis. Gridlines appear on 
the plot area to make it easy to relate values to the bars or columns. Only 
major vertical gridlines are shown in this chart.

 1. Click the white chart background to select the chart.

 2. On the Chart Tools Layout tab, click the Gridlines button .

 3. Choose Primary Vertical Gridlines and then choose Major and Minor 
Gridlines.

 4. Click the Data Table button .

 5. Choose Show Data Table. It appears below the chart and shows 
“Series 1” as the name.

 6. Right-click anywhere in the data table and choose Select Data. The 
source worksheet data is active and the Select Data Source dialog 
box opens.

 7. Click Series 1 in the Legend Entries list and then click Edit. There is 
no series name at this point.

 8. Key $ Sales and click OK. Click OK again. The data table shows the 
new series name.

Figure 9-13
Editing the series 

name
MayChart.xlsx

KowabungaSales 
sheet

REVIEW

You can right-click a tab to rename it.

 9. Name the sheet BarChart.

10.  Save the workbook as [your initials]9-15 in your 
folder.
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Editing Chart Data
Because a chart is linked to its data, changes that you make in the worksheet 
are reflected in the chart. You can add categories or value series to your data 
and then to its chart.

Exercise 9-16 EDIT CHART DATA

 1. Click the KowabungaSales tab in [your initials]9-15. Notice the pie-
slice size for Manitoba and its corresponding value in the worksheet.

 2. Click the BarChart tab. Note the length of the bar for Manitoba.

 3. Click the Chart1 tab. Note the height of the Manitoba column.

 4. Click the KowabungaSales tab.

 5. Click cell C10, key 900000, and press Enter . Notice the larger pie slice 
for Manitoba.

 6. Click the Chart1 tab. The height of the Manitoba column is 
increased.

 7. Click the BarChart tab. Note the length of the Manitoba bar.

Exercise 9-17 ADD A DATA POINT

If you add another country and its total to the worksheet, you add a data 
point to the data series. If you insert the new data within the chart’s current 
data range, it appears automatically in all charts linked to the data. If you 
add data below or above the chart’s original source data range, you need to 
reset the data range for each chart.

 1. On the KowabungaSales sheet, insert a row at row 12.

 2. Key Ontario in cell B12. Key 1000000 in cell C12. This data is not 
within the existing data range for the charts.

 3. Right-click the white background area for the pie chart. Choose 
Select Data. The Select Data Source dialog box opens, and a moving 
marquee encloses the current data range.

 4. Click Cancel. The data range shows sizing handles at each corner.

 5. Position the pointer on the bottom-right handle for cell C11. A two-
pointed sizing arrow appears.

 6. Drag the sizing arrow to include the Ontario information. The chart 
is updated when you release the mouse button.

 OBJECTIVE 4 OBJECTIVE 4

  Objective 4 Assignment:
Exercises 9-28 (Skills Review); 9-30, 9-32, 
and 9-33 (Lesson Applications); 9-34 and 
9-35 (On Your Own) can be assigned after 
completing Objective 4.
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 7. Click the Chart1 tab.

 8. Right-click the white chart background. Choose Select Data. The 
Select Data Source dialog box opens on top of the KowabungaSales 
tab with the current data range selected.

 9. In the Chart data range entry box, edit the address to show $C$12 
instead of $C$11. Click OK. The column chart is updated to include 
Ontario.

Figure 9-14
Adding a data point

9-15.xlsx
KowabungaSales 

sheet

c
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10.  Click the BarChart tab. Right-click the white chart 
background.

11.  Choose Select Data. Move the dialog box so that you 
can see the range.

12.  Click cell B6 and drag to select cells B6:C12. Click 
OK. There is now an Ontario bar.

13.  Insert a row at row 10 on the KowabungaSales sheet.

14.  Key Great Britain in cell B10 and 250000 in cell C10. This data point 
is within the existing data range for the charts.

15.  Click each sheet tab to see the Great Britain data.

Exercise 9-18  ADD AND RENAME 
DATA SERIES

If you add a second product to the data, you can then create 
a second series for the column and bar charts.

 1.  On the KowabungaSales sheet, key KowOwow in cell D4.

 2. Key the following values in cells D6:D13:
D6 60000
D7 120000
D8 45000
D9 150000
D10 300000
D11 250000
D12 100000
D13 750000

Figure 9-15
Edit Data Source 

dialog box
9-15.xlsx

KowabungaSales 
sheet

REVIEW

The dialog box collapses as you drag. 
It expands when you release the mouse 

button.

NOTE

A pie chart has only one series.
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 3. Format the label and values to match the rest of the worksheet.

 4. Click the Chart1 tab. Right-click the white chart background and 
choose Select Data.

 5. In the Chart data range entry box, edit the address to show 
$B$6:$d$13. Click OK. The column chart now shows two columns 
for each province/country, one for each product. The British 
Columbia data has a different color scheme due to your earlier 
change. Your colors may be different from the text figures.

Figure 9-16
Adding a data series

9-15.xlsx
KowabungaSales 

sheet

 6.  Right-click any column for Series 1 (Kowabunga). 
Choose Select Data.

 7.  Click Series 1 in the Legend Entries list and click Edit.

 8. Key Kowabunga and click OK.

 9. Click Series 2 in the list and click Edit. Key KowOwow and click OK.

 10. Click OK again. Hover over several columns to view the series’ 
names.

 11. Right-click the Kowabunga column for British Columbia. Choose 
Reset to Match Style.

 12. Click the white background.

 13. On the Chart Tools Design tab, choose Style 6.

REVIEW

Hover over a column to determine which 
one represents “Series 1.”

c
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Exercise 9-19  DELETE DATA POINTS 
AND A DATA SERIES

 1. Click the KowabungaSales tab.

 2. Delete rows 8 and 9. The pie chart is updated.

 3. Click the BarChart tab. Click the Chart1 tab. The British Columbia 
and Costa Rica data is removed from all charts.

 4. Click the KowabungaSales tab.

 5. Delete cells D6:D11. This is an entire data series.

 6.  Click the Chart1 tab. The second column 
(KowOwows) is gone, but the category labels appear 
out of alignment with the columns.

 7.  Right-click any column and choose Select Data. KowOwow is still 
listed as a series.

 8. Click KowOwow in the Legend Entries list and click Remove.

 9. Click OK.

Using Images, Gradients, 
and Textures for a Data Series
You can change from a solid color to a gradient or an image for columns, 
bars, pie slices, and other chart objects. Gradients and textures can be used 
to better distinguish bars, columns, or slices on a black-and-white printer. 
Images allow you to show a picture to represent the data.

You can insert an image, a gradient, or a texture by selecting the chart 
object and:

• Clicking the Shape Fill button  on the Chart Tools Format tab.

• Clicking the Format Selection button  on the Chart Tools 
Format tab or the Chart Tools Layout tab. 

• Right-clicking the object and choosing Format Data Series or Format 
Data Point.

Exercise 9-20 USE AN IMAGE FOR A DATA SERIES

If you want to use an image in a bar or column chart, it looks best if you use 
a two-dimensional chart rather than 3-D.

 1. Click the BarChart tab. Select the chart and then click the Chart Tools 
Design tab.

 OBJECTIVE 5 OBJECTIVE 5

NOTE

You can delete any chart object or 
the entire chart by selecting it and 

pressing Delete .

  Objective 5 Assignment:
Exercises 9-31 (Lesson Applications) and 9-36 (On Your 
Own) can be assigned after completing Objective 5.

Students need the Kowabunga 
image file.
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 2. Click the Change Chart Type button . The Change Chart Type 
dialog box lists all the available types.

 3. In the Bar group, choose Clustered Bar (first icon, first row) to change 
the chart to a two-dimensional chart. Click OK.

 4. Click any bar in the chart. All the bars show selection handles.

 5. Click the Chart Tools Format tab. Click the Format Selection button 
. The Format Data Series dialog box opens.

 6. On the Fill pane, choose Picture or texture fill.

 7. In the Insert from group, click File.

 8. Navigate to the folder with Kowabunga to find the image.

 9. Choose Kowabunga and click Insert. The picture is inserted in the 
bars and stretched to fit the length of the bar. Move the dialog 
box to see.

 10. In the dialog box, click to select Stack. The image is scaled to fit and 
repeat across the bars.

Figure 9-17
Inserting a picture

9-15.xlsx
BarChart sheet

 11. Click Close.
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Exercise 9-21 USE A GRADIENT FOR A DATA SERIES

A gradient is a blend of colors. A gradient can give a special effect to bars, 
columns, or pie slices in a chart. In Excel, you can build blends that use one, 
two, or more colors, or you can choose from preset gradients.

 1. Click the Chart1 tab.

 2. Right-click any column and choose Format Data Series.

 3. On the Fill pane, choose Gradient fill. The dialog box updates to show 
the related options.

 4. Click the arrow for Preset colors. A gallery of preset color blends opens.

 5. Find and click Moss (first tile, third row). Click Close.

 6. Right-click any column again and choose Format Data Series. Click Fill.

 7. In the Gradient stops group, verify that Stop 1 is current. A stop is a 
color in a gradient and refers to a position on a color scale.

 8. Click the arrow for Color and choose White, Background 1.

 9. Click the arrow next to Stop 1 and choose Stop 2. This will be your 
second color.

 10. Click the arrow for Color and choose Black, Text 1.

 11. Click the arrow next to Stop 2 and choose Stop 3. This is a third color 
from the Moss gradient.

Figure 9-18
Building a gradient 

fill
9-15.xlsx

BarChart sheet

The Gradient group includes presets and options for building 
gradients with several colors. Encourage students to experiment.
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12. Click Remove to use only two colors (two stops).

13.  Click the arrow for Direction. Several variations of 
the way in which the colors blend are shown in a 
gallery.

14. Find and choose Linear Up.

15. Click Close.

Figure 9-19
Using a texture as fill

9-15.xlsx
KowabungaSales 

sheet

NOTE

The Direction choices depend on the Type 
of gradient.

NOTE

If you’re using a black-and-white printer, 
colorful gradients print as shades of gray.

Exercise 9-22 USE A TEXTURE FOR A DATA POINT

A texture is a background that appears as a grainy, nonsmooth surface.

 1. Click the KowabungaSales tab.

 2.  Click the pie to select it. Click the Manitoba slice to 
select that slice only.

 3. Right-click the slice and choose Format Data Point.

 4. On the Fill pane, choose Picture or texture fill.

 5. Click the arrow with Texture. A gallery of available textures opens. 
Notice that textures look similar to marble, wood, or canvas.

TIP

Point at the slice, not the data label within 
the slice.
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 6. Hover over several texture tiles. A description appears with the 
name.

 7. Choose White marble. Click Close.

 8. Select only the Ontario slice. Click the Chart Tools Format tab and 
then click the Format Selection button .

 9. On the Fill pane, choose Picture or texture fill.

 10. Click the arrow with Texture and choose a different texture. Click 
Close.

 11. Click a cell in the worksheet. Save your workbook as [your initials]9-22 
in your folder.

 12. Close the workbook.

Creating a Combination Chart
A combination chart is a single chart that uses more than one chart type or 
different number scales. A combination chart has at least two series or sets 
of values. Some combination charts use the same chart type for each series, 
but a secondary number scale. A secondary axis is a set of axis values that is 
different from the first (primary) set.

Exercise 9-23  CREATE A CHART WITH 
TWO CHART TYPES

 1.  Open ComboChart.

 2.  Select cells A4:C9 and press F11 . A new chart sheet 
is inserted and plots two products.

 3.  On the Chart Tools Design tab, click the Select Data 
button .

 4.  Choose Series 1 in the Legend Entries list and click Edit.

 5. Key Kowabunga and click OK.

 6. Edit Series 2 to display KowOwow and click OK.

 7. Click OK again. The legend is updated.

 8. Right-click any Kowabunga bar and choose Change Series Chart Type.

 9. In the Line category, choose Line with Markers. Click OK. The 
Kowabunga series is now a line chart.

 OBJECTIVE 6 OBJECTIVE 6

NOTE

The formulas in columns D and E multiply 
the price by the number sold.

  Objective 6 Assignment:
 Exercise 9-29 (Skills Review) can 
be assigned after completing 
Objective 6.
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 10. Right-click the line and choose Format Data Series.

 11. On the Line Style pane, set the Width to 2 pt.

 12. On the Line Color pane, choose Black Text 1 as the Color.

 13. On the Marker Options pane, choose Built-in. Set the Size to 10. Click 
Close.

 14. Click the white chart background. The markers should be the same 
color as the line.

 15. Right-click the line and choose Format Data Series. On the Marker Fill 
pane, choose Solid fill. Then set the color to match the line color.

 16. On the Marker Line Color pane, choose Solid fill and the same color. 
Click Close.

 17. Save the workbook as [your initials]9-23.

Exercise 9-24 BUILD A CHART WITH TWO SERIES

You can show the dollar sales and the number of items sold on the same 
chart. These values will be two different series on the chart.

 1. Click the KowabungaSales tab.

 2.  Select cells A4:A9, C4:C9, and E4:E9. This represents 
the number of KowOwows sold and the sales dollars.

 3.  Click the Insert tab. Choose a Clustered Column 2-D 
chart.

 4. Click the Move Chart button  and place the chart on its own 
sheet. There are two series, one for the product and one for the 
dollars. Both series use the same value axis, so the dollar column is 
disproportionately taller.

Figure 9-20
Changing the chart 

type for a data series
ComboChart.xlsx

Chart1 sheet

NOTE

Ranges for a chart need not be 
contiguous. Use Ctrl  to select 

noncontiguous ranges.
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 5. Right-click the legend and choose Select Data.

 6. Change Series 1 to display Number Sold.

 7. Change Series 2 to Dollar Sales and click OK. Click OK again.

 8. On the Chart Tools Layout tab, click the Chart Title button . Choose 
Above Chart.

 9. Edit the placeholder to show Units and Dollars.

Exercise 9-25 ADD A SECONDARY AXIS

Because the values are very different, you should use two axes on the chart, 
one for the number of items and one for the dollar amounts. To use a 
secondary axis, use different chart types for each data series.

 1. Right-click any Dollar Sales column and choose Change Series Chart 
Type.

 2. In the Area category, choose Area. Click OK.

 3.  Right-click somewhere in the area and choose 
Format Data Series.

 4.  On the Fill pane, choose Gradient fill. Click the arrow 
with Preset colors and choose Moss. Click Close.

 5. Right-click a Number Sold column and choose Format Data Series.

 6. On the Series Options pane, choose Secondary axis. The selected series 
will be plotted on a separate value axis. Click Close.

Figure 9-21
Using a secondary 

axis in a chart
9-23.xlsx

Chart2 sheet

NOTE

Some chart types cannot be combined. 
Excel displays a message if you choose 

charts that cannot be combined.
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 7. Right-click the legend and choose Format Legend.

 8. On the Legend Options pane, choose Bottom and click Close.

 9. Save the workbook as [your initials]9-25. Close the workbook.

Using Online Help
In addition to charts, you can use many types of images and graphics in 
a worksheet. Unlike charts, SmartArt graphics and shapes are usually not 
based on worksheet data.

USE HELP TO LEARN ABOUT GRAPHICS

 1. In a new workbook, press F1 .

 2. Find and review topics about using SmartArt Graphics in a 
worksheet. Then find topics about shapes.

 3. Close the Help window when you are finished reading about 
graphics and shapes.

Lesson  Summary

• Charts can be objects in a worksheet, or they can be separate chart 
sheets.

• A chart is linked to the data that it is plotting. If the data is edited, the 
chart reflects the changes.

• A chart includes many individual elements that can be formatted and 
edited.

• Right-click a chart element to see its shortcut menu.

• Charts show data series, which are the chart’s values. A pie chart can have 
only one series, but other types of charts can show multiple data series.

• You can make many chart changes directly on the chart.

• If you select data and press , Excel creates an automatic column 
chart sheet.

• Excel’s standard types of business charts include bar, column, line, and 
pie charts.

• Move a chart by selecting it and dragging it. Size a chart by dragging 
one of its selection handles.

• After a chart is created, you can add a data point or an entire series to it.

• Although charts typically use solid color for columns, slices, and bars, 
you can use images, textures, or gradients to add visual appeal to your 
charts.

9

UNIT 3 Enhancing Worksheet Appearance

Encourage students to follow the steps in “Using Online 
Help” (with a blank document open). Software companies are 
increasingly using their Help programs—rather than paper-based 
documentation—to train users and assist in answering questions.

Encourage students to use the 
Lesson Summary to review 
the important concepts in this 
lesson.
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• You can apply effects to the shapes used in a chart to include shadows, 
glows, bevels, and more.

• A combination chart has at least two series and uses different chart 
types for each series.

• Some combination charts use a single chart type with a secondary axis 
because the series values are disproportionate.

LESSON 9  Command Summary

Feature Button Task Path Keyboard

Axis, add  Chart Tools Layout, Axes 

Axis, format  Chart Tools Format,  Ctrl � 1

  Current Selection 

Axis titles, add  Chart Tools Format, Labels 

Chart object, create  Insert, Charts Alt � F1

Chart sheet, create  Insert, Charts F11

Chart title, add  Chart Tools Layout, Labels 

Chart type  Chart Tools Design, Type 

Data labels, add  Chart Tools Layout, Labels 

Data labels, format  Chart Tools Format,  Ctrl � 1

  Current Selection 

Data series, edit  Chart Tools Design, Data 

Data series, format  Chart Tools Format,  Ctrl � 1

  Current Selection 

Data table, add  Chart Tools Layout, Labels 

Legend, add  Chart Tools Layout, Labels 

Legend, format  Chart Tools Format,  Ctrl � 1

  Current Selection 

Move chart  Chart Tools Design, Location 

Selection pane  Chart Tools Format, Arrange 

LESSON 9 Building Charts

Point out that the Command Summary lists a variety of ways to 
accomplish a specific task. Students can decide which method 
they prefer to use for a specific purpose.
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